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Policy Uses of National Heath Accounts

NatIonal Health Accounts (NHA) are a powerful tool that can be
used to Improve the capaCity of deCIsIOn makers to Identify health
sector problems and opportumtles for change and to develop and
m011ltor reform strategies

The u~e of natIOnal health expenditure accounts In polIcy makIng IS
a recent phenomenon This sectIOn will revIew NHA polIcy research and
some of ItS polIcy uses In Egypt Jordan the PhilIppInes and the Umted
States We wIll also look at the polICy relevance of cross natIOnal
analyses based on the experience of the OrgamzatlOn for EconomIC
Cooperation and Development (OECD) countries WhIle these examples
Illustrate the Importance of NHA data for polIcy makmg they also show
that natIOnal health expenditure analyses like any research can be
mIsused mlsll1terpreted and/ol dlSI egal ded

E~ypt

In Egypt a first round estImation of NHA was mltlated through
donal fundmg On the Ielease of the NHA estimates Egyptian
policymakers and donal s alike used the estImates for advocacy and
plannll1g purposes Havll1g appreCIated the utility of the fIgures second
lnd tllll d round e"tllllatlOl1 was I equested bv the govell1111el1t of Egypt

The 1995 Egypt NHA showed that total public finanCIng came to 1 8
percent of gross domestic product (CDP) whIle private finanCIng
cOl1tllbuted almost double 2 7 pel cent of CDP Whlie such a level of
publiC expenditures on health IS relatIvely high In comparison With
countries at a Similar Income level private expenditures are much
hIgher than III the majority of countries for which accurate data eXist
As a percentage of CDP, Egypt generates more private financlIlg for
health than most other countries at least when the whole health system
IS conSidered suggestIng that the perception of Egypt as a country With a
relatIvely low level of cost recovery III ItS health sector IS untrue

The analySIS of publIc expendIture conducted as a part of NHA also
yIelded IIlterestlllg results Overall MInIstry of Health (MOH)
expenditures Increased 14 percent In real terms eqUIvalent to a 5
percent IIlcrease III real per capita fundIng over four years DUring thiS

Preface
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same time perIod the governorate share of actual MOH expenditures
declined from 89 percent to 75 percent OWing to a significant Increase
In the share of resources allocated at the MOH headquarters level
Consequently on a real per capita basIs the amount of resources
directly allocated to most governorates fell substantially

Jordan

A health sector study conducted In Jordan estImated the finanCIal
effects of several reform proposals USing National Health Accounts as a
POint of departure The government ofJordan wished to conSIder
proposals for universal health care coverage for ItS CItIzens, while the
financer ofJordan's health reform planning WIshed to explore the
financIal effects of such a policy change Consultants assessed the
probable finanCIal Impact of the varIOUS policy optIOns, WhICh Included
the expansIOn of the current subsidIzed care and cost sharIng system
wIthm the MOH, the expanSIon of the SOCIal SecurIty CorporatIOn andlor
the ImplementatIOn of employer mandates or other natIOnal approaches
(for example SIckness funds or general revenue financed systems)

The analysts first chose a base year for the NHA analySIS and
projected forward or backward dependmg on the data avaJiable Once a
base year NHA had been developed and expenditures that would not be
affected by the policy change omitted from the matrIX (such as public
health servIces) the researchers attempted to quantify the changes In
spending that would occur as the result of each policy optIon These
antICIpated changes served as the baSIS for the adjustment of the figures
In the base year NHA matrIX

Expenditure changes that occurred as the result of the reforms were
generated through the adjustment of the base year NHA matrIX along
three axes ll1ductlon payment rates and effiCIency The inductIon
Impact of a reform IS the change Il1 total spendll1g caused by a change In
the out of pocket expenses assoCIated WIth recelVll1g servIces through
universal coverage or more broadly the changes ll1 total expenditure
that are ll1duced by othel changes Il1 expenditure that occur as the Iesult
of a system change A second set of adjustments was made as the result
of changes In payment rates or protocols Finally the matrIX was
adjusted accordmg to the I eforms Impact on effiCIency (If any) for
example a reform that shifts servIces from overcrowded faCIlities to
underutllIzed faCIlIties may raise effiCiency whIch may m turn affect
expenditure estimates among the varIOUS proViders

WhIle provldmg some mterestll1g mdlcatlve results for health policy
deCiSion makers, the Jordan study was done qUIckly WIth avaIlable figures
The study only exarnmed changes m expendItures that would have an
Impact on government expendIture patterns whIle paymg msuffiCient
attentIon to the under-studied prIvate sector More sustamed natIOnal
efforts are needed to strengthen the completeness and accuracy of the
analySIS The study s use of NHA as a startmg pomt proVIded a framework
for mtegratmg data and assumptIons consistently The NHA framework
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allowed analysts to watch the whole system while modelIng the Impact of
reform and makmg explICIt adjustments for any factors needed

The Phlllppmes

WIth fundIng from ll1ternatlonal financIal instItutIOns the Ul1Iverslt\
of the PhIhppmes School of Economics and the Department of Health
(DOH) undertook the estImatIOn of NatIOnal Health Accounts The
collaborators were able to speCify the contmuatlOn of NHA beyond the
project life and lI1stItutIonalIze the collection of NHA data WIthin the DOH
The group also 111ltlated the development of proVinCIal health accounts

Fmdmgs from the 1991 estimatIOn generated conSiderable debate
m the PhllIppme legIslature m February 1995 around the low percentage
of expenditure and coverage of sOClalmsurance schemes (12 percent of
the total expendIture) and the relatIvely high level of government
expendIture (44 percent) Unfortunately legislators responded to these
figures by passmg a bIll to expand sOClalmsurance Without performmg
any of the requIsite finanCial analyses whICh has resulted m a finanCially
unsustamable msurance scheme (Hernn, 1996)

The FllIpmo NHA team recogl1lzmg the hmltatlOns of a smgle year
estimate of NHA employed a polIcy Simulation methodology m order to
sustam mterest around the NHA as a tool for analyzmg health care
polIcy (Solon and Tan 1996) ThiS model defines the underlymg
elements of each NHA cell and varIes them accordmg to historIcal
patterns and other speCIal studies In order to SImulate the effects of
SOCIalIzed prIcmg of publIcly proVided services The results of the
simulatIOn showed that total health care spendmg would mcrease With
SOCIalIzed prICll1g (mcome based dlscrImmatory pncll1g) As pubhc
serVIces prIces ll1crease wealthier groups shift to more expensive
prIvate services Nonetheless the revenue gam from the wealthier
consumers who contll1ue to use publIc servICes more than compensates
fOl the lI1creased subSidy reqUIred for poor consumers As government
faulItles practIce ll1come based pI Ice dISCIlmll1atlon reliance on public
and prIvate lI1surance coverage ll1creases FlI1ally out of pocket
expenditures also mcrease as rIcher lI1come segments mcreasmgly
access pnvate sector sel vices Accordll1g to HerrIn the SimulatIon gave
POllCymakers answers to their what If questIons allOWing for data
mstead of speculation to fuel polIcy debates

The sImulatIOn was demandmg m terms of data The NHA team
used three natIOnal sample surveys a speCIal survey of households,
hospitals and outpatient clImes the Family Income and ExpendItures
Survey and the NatIOnal Health Survey However, for data poor countrIes a
Simpler versIOn of the same model could be utIlIzed effectively

Under a Umted States Agency for InternatIOnal Development
(USAID) supported project the FIllpmos were also able to estimate
national famIly plannmg expendItures wIthll1 an NHA framework findmg
that donors accounted for approximately 35 percent of all fundmg for
famIly planmng actiVitIes more than the government Itself Further the
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flow of funds study showed that the great majority of these funds were
absorbed Into the admmlstratlve expenses of USAlD and theIr
cooperatmg agenCIes These findmgs should have great slglllficance to
the sustaInablhty of the donors' efforts

Umted States

•

x

Smce 1964, the Health Care Fmancmg AdmInIstratIon (HCFA) of the
U S Department of Health and Human ServIces has pubhshed an annual
series of statIstIcs descrlbmg total natIonal health expendItures for each
year HCFA IS regularly called upon to report on emergIng expenditure
patterns and problems and to model the financIal effects of pohcy
reforms under consIderatIOn m the executIVe branch and m the
legIslature HCFA attempts to remam close to current pohcy debates m
the U S legIslature through the release of a seasonal Journal the Health
Care Fmancmg RevIew and frequent pubhcatlons m other health pohcy
Journals such as Health Affairs Data Watch The U S NHA remams close
to ItS users through periodIC evaluatIons of sources defillltlons and
categories and frank CritIcal revIew of estImates generated HCFAs
NHA estImates serve as the basIs for the U S government s submISSIon
to the OECD health expendIture data banks, bemg consIdered more
rehable and detaIled than health expendIture estImates generated
through the NatIOnal Income Accounts In combInatIon with the OECD s
work the U S NHA IS the model for the mstltutlOnahzed collectIon of •
natIOnal health expendIture data-the NHA serves as both a generator
of pohcy debate and an evaluator of pohcy mstruments Only one further
apphcatlon of NHA wIll be hlghhghted here mterested readers should
refer to Lazenby et al (1992) for more InformatIon on the NHA system

Of potentlalmterest to Increasmgly decentrahzed governmental
systems HCFA has recently promoted the pohcy use of state health
expenditure accounts The current effort to develop and expand state
health expenditure accounts began dUring the 1993 94 health reform
debate as pollcymakers began to questIOn the effect of natIonal polICY
options on lI1dlvldual states Those health reform efforts faIled
subsequently the focus shifted to the efforts of the states to grapple
WIth the contmued rise m the number of unmsured lack of avaIlablhty
of health msurance to many employed workers mandated MedIcaid and
Medicare expanSIOns state budget constramts agIng populations and
uncompensated care Several states, such as Oregon and Flonda,
mdependently Implemented major reforms m theIr health systems

State level expendIture estImates are mstrumental m measunng the
dIfferentIal Impact offederal pohCles and state specIfic mltlatlves on
mdlvldual states Personal health care expendItures were exammed over
a 13 year penod and these figures showed WIde vanatlon In level and rate
ofgrowth of regIOnal spendIng per person These statIstICS were also able
to quantIfy dIfferences In both the percent of health care costs m each state
borne by MedICare and MedICaId and In the proportIon of each state s
economy devoted to the provIsIon of health care
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cross-national Compansons The DECO Countnes

The OECD Health Data FIle IS the first attempt to compIle and
process offiCIal data on natIonal health expendItures at the mternatlOnal
level OECD analysts use readIly accessible mformatlOn from constItuent
countrIes and adjust thiS data to produce comparable Units GIven the
heterogeneity of data and clasSificatIOn systems among OECD natIOns
analysts have focused on reductlOnIst aggregates that can be reasonably
compared These mclude total expendIture on health, publIc
expendIture on health, total and publIc expendIture on mpatlent care
total and publIc expenditure on ambulatory medical servICes total and
publIc expendIture on pharmaceutICal goods, and publIc expenditure on
capItal goods for medIcal care In addItIOn, the OECD calculates price
mdlces for inpatient care, ambulatory medIcal care and pharmaceutICal
goods and an aggregate Index of medICal care and health servIces with
whICh to adjust estImates for comparison purposes OECD also looks at
SOCIal protectIOn (coverage of dIfferent costs) and publIc partIcIpatIOn
(government s share of blllmg for mpatlent and ambulatory care),
utIlizatIOn of medIcal servIces and avaIlable personnel resources,
selected variatIOns In common medICal care practICe selected health
status mdlcators (life expectancy and mortalIty rates) and demographiC
and general economic background data (PoullIer 1990)

The OECD data base has generated a substantIal number offurther
analyses The OECD Itself has compared health systems through levels
and trends m relatIve (share of GDP) and absolute spendmg analyzed
through share of GDP percentage change m relatIve and nominal per
capIta health spendmg compared to relatIve and nominal per capita
GDP and comparIsons In absolute levels of health spending through the
use of GDP Purchasmg Power ParItIes (PPP)

Health expenditure trends have also been decomposed to show
excess health care mflatlon and mcreases m volume intensIty
(utilIzatIOn) per capIta the two basIc endogenous factors drIvmg health
expendIture change These analyses rely on valId Informatlon on health
care pnces and overall health spending The OECD uses prIce indICeS
based on extant indices for mdlvldual countrIes and does not adjust for
prodUCtiVIty changes over tIme

The OECD has made cross-natIOnal comparIsons on the II1come of
health care professIOnals, whIch accounts for two thIrds or more of
health expendIture and shows large behaVIOral dIfferences between
countries

In more recent publIcatIOns the OECD buIlds on the well known
relatIOnship between recorded expendIture on health per capIta and
mcome per capita to generate expected spendmg at given Il1come
levels The analysIs IS conducted on over 30 years of data expressed Il1
PPPs for the OECD natIOns Interestll1gly particularly for developmg
countrIes the expected level of health spendmg Il1 the lower Il1come
per capIta countrIes appears to be broadly that of today s wealthier

NAnD\~1 HEALTH ACCDI \T'
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countnes when they had mcome levels similar to today slower
mcome OECD countnes (an mtranslgent outlier IS the Umted States)
While this finding IS interesting 10 the aggregate Improved data now
allow for correlatIOns between each subaggregate spendIng functIon
and total national expenditure In order to compare the efficiency of
different national spend10g patterns

Increasmgly comparable categones of Inpatient care ambulatory
medical services pharmaceutICal goods. and therapeutic applJances
have generated compansons of medical consumption by function
Work has been done In the comparative evaluatIOn of health outcomes
produced by health systems Fmally. analy:sts have been able to evaluate
populatIOn satisfactIOn as a functIOn of health spendmg

The comparative analyses of the OECD prOVide another perspective
on NHA and ItS uses and also serve as a model for future InternatIOnal
collaboratIOn It IS only 10 relatIOn to other nations' health systems that
anyone national system be Judged as efficient or equitable For
example It was In contrast to the other OECD countnes that exorbitant
U S spending on health became recognized 10 ItS full dimenSIOns

•



How to Use This Manual

ThIS manual IS dIvIded Into four maIn parts each wIth a dlfferept
purpose

Overview

The Preface addresses the polIcy uses of NatIonal Health Accounts
and with Chapter 1 provIdes an overview and context for the NatIonal
Health Accounts methodology and software How can It help you analyze
the flow offunds In your country's health care system? Why should you
use NatIonal Health Accounts? What do you need to perform your
analysIs successfully?

Getting Started

Chapter 2 helps you Install the program and become famtllar with
how to use the essentIals of the program (fyou are unfamilIar wIth how
WIndows based programs work you may want to consult the Getting
Stm ted manual that IS shIpped With Microsoft WlI1dows before you
attempt to lI1stall or use NatIOnal Health Accounts

BasIC Skills

Clnpter 3 covers the NatIOnal Health Accounts method In gl eater
detaIl and descrIbes how to use the dIfferent data entrv \\ lI1dows

Advanced Skills

Chapter 4 explaInS how to use the more compltcated aspects of
National Health Accounts through a gUided tour of the fll st matrIX
Sources to Fmancmg Agents Chapter 5 looks at other matnces Chapters
6 explaInS how to pnnt and export your data Chapter 7 how to handle
the program s specIal tools

Examples

ThiS manual uses a NatIonal Health Accounts project the Egyptian
Health Care System to Illustrate procedures descrIbed m the text ThIS
file EXAMPLE NHA IS shipped as part of the lI1stallatlon It IS Included as
a common reference pomt for the manual and for users who seek to
apply National Health Accounts

Introduction
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Who Can Use This Manual

This software IS Intended to be a tool for developIng country
analysts and deCisIon makers In the development of a regular system of
NHA



What are National Health Accounts!

1.1 Pohcymakers and Health Expenditure Data

In the health sector as In any sector the resources available to
meet national goals are limited In the past several decades, this
scarcity of finanCIal resources In the health sector has increasingly led
countrIes to take stock of natIOnal health resources used review
allocatIOn patterns assess the effiCIency of eXisting resource use and
study and evaluate health financing options The pnmary difficulties In
undertaking these analyses have been (1) the lack of informatIOn on
health expenditures and (2) not uSing eXisting informatIOn to Improve
the planning and management of health sector resources

For many years a vanety of gUidelines and formats have been
proposed for the collectIOn of natIOnal health expenditure data In the
public and pnvate sectors (Abel-Smith 1963, 1967 Zschock et al
1977 Gnffiths and MIlls 1982 Mach and Abel Smith 1983
Newbrander et al 1994) Some argue that the informatIOn be collected
as an extension of natIOnal Income accounting (Abel Smith 1963,
1967 Foulon, 1982 Cumper 1986) Others advocate uSing elements of
natIOnal Income accounting In order to preserve compatibility whIle
still preparing separate estimates for the health sector for use In policy
making (Berman and Rannan-ElIya 1993 Berman 1996 Waldo 1996)
Most authors however agree that a standard set of health activities
definItions and expenditure categones across countrIes would Increase
the utilIty of the informatIOn for both national and internatIOnal
polIcymakers and analysts Standard organIzatIOn tabulatIOn and
presentation of data will also enhance the policy relevance of health
expenditure informatIOn

1.2 The National Health Accounts Framework and
Software

A NatIOnal Health Accounts (NHA) framework IS one way to
organIze tabulate and present health sector expenditure informatIOn
The expenence that the UnIted States and the nations of the
OrganIzation for Economic CooperatIOn and Development (OECD)
natIOns have had with the NHA methodology shows that the NHA

Chapter 1
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matrIces can hIghlight policy problems enhance cross country
comparabIlity, and thus Increase the likelihood that data collectIon
efforts WIll be repeated regularly

The Harvard NHA software was developed In 1996 However
varIants of the NHA methodology have been utIlized In the Umted States
and the DECO countrIes for the past 20 years

The NHA framework elaborated In thIs software package IS deSIgned
to capture the totality of expendIture flow In the health sector The
framework does not Include standard defimtlOns and categorIes-these
must be determIned through a combInatIOn of natIonal and International
dIScussIons and consensus about prIorItIes It does however, provIde an
analytIcal framework consIstIng of three essential elements FIrSt It
requires the calculatIOn and presentation of natIOnal estImates through a
sources and uses' matrIX Second, It allows for extensIve dIsaggregatIon

of the sources of spendIng beyond the general categorIes of public and
"prIvate ThIrd It provIdes a systematIc framework for definIng uses
accordIng to several Important, and mutually exclUSIve classificatIOns

The "sources and uses" method Imposes an Important dISCIplIne on
natIonal health expendIture analySIS, whICh typIcally consIsts of
separately compIled estImates of expendItures by sources and by types
of provIders, e g hospitals and doctors The matrIX approach requIres
that all expendItures estimated by the dIfferent sources be allocated to
speCific uses for example, all spendIng on government hospItals must be
traceable to the speCIfic sources The totals and subtotals must add up
and be consIstent The software ensures thiS outcome through a serIes
of consIstency checks and reports

The matrIX reqUIres analySIS not only of the subtotals and theIr
aggregates, but also an understandIng of the flow of funds through the
health care system It stresses the need to know In an Integrated way
who pays, how much and for what rather than SImply separatIng the
who from the what For thiS reason, the NHA methodology Includes an
IntermedIate category, "finanCIng agents," that allows for the dIVISIon
between the finanCIng and proVISIOn of services The software IS able to
display thIS InformatIon both In a matrIX and a graph The flow of funds
charts allow the user to vIew the finanCIng and proVISIOn arrangements
In a health systems In one glance

ThIS capabIlIty of lInkIng sources and uses IS an Important aspect of
the value of NHA for analyZIng health care finanCIng poliCIes ThIS IS
because health finanCIng IS not solely concerned WIth raISIng funds for
the health sector, but also plays an Important role In determInIng the
allocatIOn of expendItures and the behaVIOr of proViders and consumers
PolICies that affect the practICe of the financers of health care (the
sources) need to be deSIgned momtored, and evaluated In terms of their
Influence on the uses of funds In the health sector both In terms ofwho
receives them and what they produce as a result The "sources and uses'
method IS the means to that end



In addItIOn the software IS suffiCiently flexIble to allow for a vanety
of matnx presentatIons FIrst the program allows the tradItional NHA
analyses sources to financing agents and financing agents to provIders
It then Includes frameworks for the analysIs of expendIture flows from
financing agents to specIfic functions and line Items Fmally, the program
mcludes empty matnces that can be used for addItional descnptive
analyses such as the flow of funds from financing agents to provinces or
states In a decentralized system or from financing agents to
SOCioeconomIC classes In an assessment of eqUity

Matrices

WH4T ARE !li4no~AI HE4lTH ACCOUNT>?

The first step m the National

Health Accounts analYSIS IS to
choose a matnx.

Sources to FlnanCln~ A~ents

National Health Accounts step by step

Deline~£.rofile I
I Stall your analy_ of the flow of fun<k .. the hea\lh-care r.:,..=---=--=--:<1
$1I$Iem WIth the Sour_ of fun<k T._the flow ftom the CPSOUlt:e$1o
Sources 10 the Financing Agents. $~

IV Detenmne how F..ancmg Agent. aRocate reoources10­
diIIenng lme Items

FmanCln~ A~ents to Providers

Flnancln~ A~ents to Functions

Flnancln~ A~ents to lme Items

Other Matrices

II Next delenDlne the flooR of ,eooutees hom the
FInancIRg Agenls to the __ PnMdeJ. othea\lh ""'"
and ,elated g ....... and _

III Analy,ze how FInancIRg Agent. distribute lundo on the
""- 01 FlIflCbom offered by ProYldero

V Fmally create addibonal__ such ao F_g
Agent. to RegJOno Of Soc"" ClaIse. to FIflIIflf:lI1!J Agent<
Of 0_ po..mle analyoeo.

Help Close File" l:.\NHA\EXANPLE.NHA

$ FlIlOI'1CIllg
~~lo+PiOYtder.

~=it flBlCbono

l~
!=Lileu....

I 2~ I
I Ep I

The NHA software IS thus a tool that can be used to orgamze,
descnbe and present expendIture data In additIOn the software IS
Intended to support analysts and pohcymakers In their data collectIon
and analysIs and In theIr advocacy efforts WIth deCISIOn makers The
program s graphical capabIlitIes allow pollcymakers to view the structure
of health sector financmg flows clearly and qUickly

1.3 Generatm~ Estimates for the Matnces

The NHA software provIdes a framework for the analySIS of the data
collected and helps keep track of data sources and quality However
generating estimates for the matrIces IS a task that remams to the
analyst A techmcal annex to thIS manual WIll reVIew the common
methods and sources for the generation of estimates from the public
and prIvate sectors and theIr strengths and limItatIOns In general the
method relies on eXisting data sources NHA does not reqUire much
complex calculatIon to fill In and complete the sources and uses
matrIces although multIVarIate analySIS of household or health facIlIty
data might be useful for determmlng specific coeffiCients used In
allocatmg certain expendIture Items to dIfferent types of uses

NATIONAL HEALTH ACCOUNT>
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A common starting POint for every user however should be the
definition of the health sector, Ie, the definitIOn of what will be
classified as health expenditure This will govern what IS Included and
excluded from the matrix estimates Within the NHA methodology as
presented In thiS program the health sector IS defined as expenditure
on actiVities whose primary intentIOn (regardless of effect) IS to Improve
health (Griffiths and Mills 1993) As the border between what are
conSidered primarily health expenditures and what are primarily
expenditures for other purposes IS blurred-for example expenditures
on family planning programs food subSidy programs and basIC hOUSing
might have various purposes-It IS vital to be clear about the primary
purpose of each expenditure For thiS reason, the indiVidual analyst or
polIcymaker must make explICit which categories to Include In or
exclude from the NHA methodology

The software user should recognize that sources and methods
used to generate estimates Will depend on the resources of each
indiVidual country

1 4 The EiQht Substeps of the NHA AnalYSIS

The NHA software gUIdes you through the five main matrices The
matrices correspond to the five main buttons on the Step by Step
screen The first step IS to choose a matriX you can fill out each matrix
In a lInear fashion or start With the matrix that Interests you and move
backwards or forwards However, some substeps (such as the Estimate
MatriX) reqUIre that you complete a prevIous substep (such as Choose
Entity) In order to carry out an analySIS

Each matriX analySIS comprises eight substeps

Substep 1 . Choose Entities

Defining entities IS a Critical first step In the analySIS (An I entity IS
any organizatIOn group, or type of use offunds employed In thiS
analySIS of expenditures) The program asks that you develop a
complete but practical categorization for all sources finanCing agents,
and uses In the health system Country-specific definitions and
categories are an Important component of thiS lIst Each entity must be
well defined and mutually exclUSive from all other entities The program
has both built In standard entities and space to add your own entities
TypICal sources are ministries of finance, international assistance
employers, and householdS/individuals TYPical finanCing agents are
ministries of health and educatIOn, other ministries SOCial Insurance
private Insurance firms, and households And typical proViders are
ministries of health teaching and university hospitals other publIc
institutIOns SOCial security agencies, nongovernmental organizatIOns
private medICal prOViders, pharmaCies and/or other private proViders



Substep 2 - Defme Flow

The program asks you to IdentIfy all the places where there IS a
flow of funds from a source to a financing agent and from a financing
agent to a use/provIder These sItes of the flow of funds WIll become the
cells to be filled-the NHA matnces

Substep 3 - Detailed Flow Dlaeram

The Detailed Flow substep takes the informatIon you have entered
In the Choose EntItIes screen and graphically dIsplays the flow offunds
between a single entity source and vanous finanCing agents

Substep 4 - Full Flow Dlaeram

The Full Flow Diagram substep graphically displays the funding
flows from all sources to all finanCing agents or from all finanCing
agents to all proViders

Substep 5 - Estimate MatriX

The EstImate MatrIX allows you to Input data through the Flow
DetaIl or QUick Entry Windows and construct a matrIX for each level of
analysIs ThIS data WIll serve as the baSIS for consIstency checks across
matrIces and for graphIC dIsplays

Substeps 6 and 7 - Graphs and MatriX Bar Graph

The Graphs and the Matnx Bar Graph substeps allow you to dIsplay
the data collected In a varIety of formats for example In a pIe chart
depICting the magnItude of the varIOUS sources of finanCing

Substep 8 - Checks and Reports

In thiS substep the program offers a consistency check on the flow
of resources across all matnces Reports allow you to print the estImate
table and compIle a lIst of Incomplete entrIes and mIssing data

I ~ Define Flow

~c~ Deladed Flow DIagram I

888 Full Flow Diagram

I ~ Esllmale Malnx

I ILiJ Graphs

I ~ Malnx Bar Graph

I rl EPT
Checks,. Reporls

NAnONAL HEALTH ACCOUNTS

5



6

Chapter 2

Note
If vou are usln~ an alternallve desktop for

Windows such as one created by Norton Desktop
or Navl~ator consult that product s
documentation on how to temporarily restore a
native Windows desktop Anemptln~ to Install
National Health Accounts uSln~ the Run command
of Norton Desktop will result In an Incomplete
Installation

How to Install National
Health Accounts

2.1 Hardware and Software Requirements

In order to use National Health Accounts, the followmg are reqUired

• IBM Compatible personal computer (MS DOS PC) with 486 or higher
mICroprocessor

• Windows 3 1 or later version

• Approximately 9 megabytes hard disk space (6 megabytes must be
available on the drIve where your WINDOWS/SYSTEM files are
located)

• 8 megabytes of memory (RAM) IS recommended

• EGA, VGA or better display

• Mouse or other pomtmg deVice

Use of National Health Accounts without a color display IS possIble
but a color mOnitor IS recommended, espeCIally for vlewmg the diagrams
and graphs PrInting of National Health Accounts reports graphs or
diagrams requires that the prInter be mstalled m Microsoft Wmdows
with the approprIate prmter drIver

2 2 Installml! National Health Accounts

Before You Install National Health Accounts

• In order to mstall or use National Health Accounts, Wmdows 3 1 or
Wmdows 95 must be mstalled and currently runnmg on your
computer Close all open applIcatlOns-mcludmg the software that IS
mmlmlzed on the Windows screen

Usmg the InstallatIOn Routme

• Dependmg on your Wmdows verSIOn, consult the approprIate
sectIOn below
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221 Wmdows 95 Installation

Check the Taskbar to ensure that there are no programs currently
running on your machine Ifno buttons (other than the Start button)
are dIsplayed you have no main apphcatIOns running

Windows 95 Installation

Plun ilEi

Type the name of aprogram folder ordocument and
Wrndows will open Uor you- - -~

Place the disk marked Installation Disk 1 m the
appropnate floppy dnve

2 Click on the Start button Select the Run option

3 Windows will display the followm~ mput box

Type A \SETUP In the Open edit box as shown m

the illustration

(If the floppy dnve you are Instalhn~ from IS dnve

B type B \SETUP In the Open edit box)

4 Press Enter or click on OK to be~1n InstallatIOn

.Qpen..

OK I Cancel !:!rowse

The Setup process wIll check your hard disk to be sure that there IS
enough space to hold all the reqUIred files It wIll attempt to place
approxImately 6 megabytes of files In your WINDOWS\SYSTEM (system)
directory If some of the files are already found In your system
directory then less new disk space will be reqUIred

The Setup process wIll ask If you wIsh to name your NatIOnal
Health Accounts folder C \NHA If you want to use the default folder
press Enter when thIS dialog box IS dIsplayed You can Install the non­
system files to a dIfferent folder by changing ItS name to another dnve
and/or folder name (for example, D \NATHLTH)

As the Setup process Installs the files It WIll prompt you to Insert
any addItIonal dIsks

The Setup program wIll alert you that NatIonal Health Accounts has
been correctly Installed You may be asked to reboot your machine

NHA Folder

Note
On some machmes the mstallatlon procedure

has been unable to create a program folder and
shortcuts If thiS occurs on your machme create
a shortcut to the main National Health Accounts
program C \NHA\NHA EXE (where C \NHA IS the
folder m which you mstalled the main program
files see above) Consult your Wmdows 95
documentation on how to create a shortcut to a
program

After installatIOn the NHA Folder Will appear
fife ~<lit YJew !:!elp

~
..

~
11III NHA

Help

.tfl~

11 obtecl(s} selected 1225KB #

(Windows 95 users SkIp the next two sectIOns) Proceed to Chapter 3

NATIONAL HEALTH AccouM:S 7
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2 2 2 Wmdows 3 1 Installation

When you start the mstallatlon routme the only wmdow open on
your screen should be the Wmdows Program Manager screen This
screen shows all the groups of programs you can run on your machme
Do not attempt to run the installatIOn routine USing the FIle Manager

Wmdows 3 1 Installation

1 Place the disk marked Installation Disk 1 In the
appropriate floppy drive

2 From the Windows Program Manager choose
the Run command under the File Menu

3 Windows will display the following Input box
Type A \SETUP In the Command hne as shown In
the illustration

(If the floppy dnve you are installing from IS drive
B type B\SETUP In the Command hne )

4 Press Enter to begin Installation

.!;.ommand Lme

la \setup

D Run M.lnrmlzed

I::"'OK"7--J
IrCancl1t1
IiiO\ft8.~-~
IF~J

The Setup process wIll check your hard disk to be sure that there IS
enough space to hold all the reqUIred files It wIll attempt to place
approxImately 6 megabytes offiles In your WINDOWS\SYSTEM (system)
dIrectory If some of the files are already found In your system dIrectory
then less new dIsk space wIll be reqUIred

The Setup process wIll ask If you WIsh to name your National Health
Accounts dIrectory C\NHA If you want to use the default dIrectory
press Enter when thIS dIalog box IS dIsplayed You can Install the non
system files to a dIfferent directory by changing ItS name here to
another dnve and/or dIrectory name (for example D \NATHLTH)

As the Setup process Installs the files, It Will prompt you to Insert
any addItIonal dIsks

NHA Prouram Manauer Group

8

When the Installation routine has completed you
will see the follOWing new Program Manager Group
and Items EXit Windows and reboot your machine to
be able to access all features of National Health
Accounts NHA

Help



2 2 3 Manually Chanf!mf! A.UTOEXEC BA.T

You may need to edit your AUTOEXEC BAT file only If all of the
folloWIng circumstances apply

• Your computer IS runnIng WIndows 3 1

• Your computer IS not runnIng WIndows for WorkGroups and

• You have encountered problems editIng your EXAMPLE NHA file

The goal of thiS step IS to be sure your AUTOEXEC BAT routIne
starts up the DOS SHARE EXE routIne (with the correct parameters)
Edit your AUTO EXEC BAT and be sure that It Includes a Ime readmg

C \DOS\SHARE EXE IL 500

(The C \DOS\ part may need to be changed If DOS IS Installed In a
different directory on your computer) If this lIne IS not present or If the
IL 500 parameter does not appear, edit thiS lIne approprIately and save
AUTOEXEC BAT You will need to eXit Wmdows and reboot your machIne
m order to access a fully functional National Health Accounts system

Usm~ the DOS Editor to Chan~eAUTOEXEC BAT

To edit AUTOEXEC BAT, use any text editor If you are unfamiliar
With the text editors available on your machIne leave WIndows and
brIng up the MS DOS Editor by typIng

EDIT C \AUTOEXEC BAT

from your C \DOS directory The MS DOS Editor will display the
contents of your AUTOEXEC BAT file Look through the file to see If
you already have a Ime which Invokes SHARE EXE If you do be sure
that the lIne contaInS the IL 500 parameter as shown on the last page
It may have other parameters which you should leave unchanged If It
does not have the lIne add It To save your changes press the Alt key
and F and choose Save Then eXit and reboot your system

Ho~ TO I~STAIl NAnO\AI HEAIT1f 4CCOI \T5

Note
In some cases the installation procedure may

be unable to edit your AUTOEXEC BAT file ThiS
Important file !loverns how your machine starts
up when you turn your machine on or reboot If
when you use National Health Accounts you are
unable to open the sample file (EXAMPLE NHA)
It IS pOSSible that your AUTOEXEC BAT file needs
to be modified manually This Will Involve edllln~

or addln~ a Sln!lle line to this speCial file The
next section deScribes how to remedy thiS
problem Ifyou do not encounter thIS problem
you do not have to manually change your
AurOEXEC BATf/le

Note
When you are USIn!l National Health Accounts

If you are unable to add rows In the tables It Is
likely that SHARE EXE IS not Installed properly

NAnONAI HEAIT1fAcCOUNT5
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Chapter 3

How to Use the National Health
Accounts ProS!ram

3 1 Startmfl the Proflram
Once the mstallatlOn procedure has been completed successfully

you should see a Program Group for National Health Accounts on your
screen m the Program Manager wmdow It will mclude two Icons one
for NatIOnal Health Accounts and one for Help Most of the time you
Will use the mam NatIOnal Health Accounts program Help IS also
accessible from wlthm the NatIOnal Health Accounts program via the
Help menu

NHA Group

Double-cllck on the National Health Accounts Icon
to start the program

(The NHA group will appear somewhat differently
when viewed In Windows 31)

Note

When Nalional Health Accounts IS started for
the first time two chOICes are available-to open
the E~ypt NHA sample proJed (EXAMPLE NHA) or
to create a new proJed

10

When you start National Health Accounts or when you close your
current file, the Welcome to NatIOnal Health Accounts or mltlal file
selectIOn wmdow IS displayed m the center of the National Health
Accounts wmdow

The last project you worked on Will be listed as the default chOice
To resume work on your last project all you have to do IS press Enter
or click on OK to resume work on your project

The Welcome screen also offers two other chOICes Select a different
file and Create a new file The Select a different file Option Will display
the Open Project wmdow which allows you to select from other
projects already on file The Create a new file optIOn Will display the
New Project wmdow where you Will define the file name for the
project and define the deSCrIption and additIOnal mformatlon about
the project
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Welcome to National Health Accounts Wmdow

The Welcome screen allows access to help Via the
Help button You can close the program by cllckmg
on the Exit button

Welcome to Nabonal Health Accounts

rl:hooRthBH~K.ataAc:c:cultttitltaWDlkQtl..----­

C"~N~HNIh.!'cc=.;;:t!fie-

C.ioloct differemfiJo

C"J:.e'eate«_Jic

_ ex

Ii""

3.2 What IS a ProJecU

When you use National Health Accounts you Will be working on a
particular project A project IS the largest diVISion of data for the
National Health Accounts system A given project contains a variety of
tables graphICS and other informatIOn just as a word processing
system focuses on a particular document-a letter or an article for
Instance-each time you use National Health Accounts you will select
a particular project file to work on

Each project file IS stored In a Single file on your disk It IS relatively
difficult to move data from one project file to another Store all your
information about a partICular analySIS In a Single project If you diVide
your data Into different projects you may find It difficult to combine
the data later

By default all project file names end With the suffix NHA Though
you can name your project files With any legal MS DOS name we
recommend you name them With the NHA suffix because the system
looks for files names With thiS suffix on disk when you choose the
Open command A typical project file starts at approximately 250 000
bytes (250K) In size

3.3 CreatmSl a New Project

To create a new project click on New Project on the FIle Menu
The system WIll display a Window which asks for the name you want to
call your project on disk The National Health Accounts system
automatically saves much of your data when operating the program so
It needs to know where you are gOing to store that data on disk

By default the system expects to save your data In your NHA
directory though you can save It elsewhere To save your data to a file
called NEWPROj NHA type NEWPROj NHA In the File Name field

NATIONAL HEAlrH ACCOUNTS 11
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New National Health Accounts Project wmdow

New NHA ~I.iect ilEi

f File name - {olden

liIm!'.l 1- ~ \nha

,;:e=ll=a=m:::;PI;::e=n:;:h=a====:;:r....~ ~ c \
E3 nha

: 1 OK I
Cancel I

tieiw~rk. I

SavE! file as ,bIpe

"No value set

NHA Model Vear Egppt LE / 1 US 12 0000
Dollar~.::;:;:;::::

NHA Model Vear E_t LE / Jo'::: 10 3100

Once you have chosen the disk, directory and name for your new
proJect, chck on OK

3.4 The Country Profile Screen

After you have created a new NatIOnal Health Accounts project and
chosen a name for the new project file, the program Will display the
Country Profile screen Use thiS screen to enter general information
about the country bemg analyzed such as the umt of currency model
and base years and other values that apply to your entire project

Country Profile Window

III Ceuntrl' !',.file I!!I~D

Country Name 1l::!Il'pt CUllen", Un,t IE!Il'ptlE

.----,--..,--='==::::::::=======-'r--=-~Nmne~' :;::;:;:;::::;:;:::;:==::::
Coefflcents 101 NHA Model Veal COelficenlllot Real Value Calcula!lom

Dataentmed m thl$ model 1$11991 B_ Vear lot Real Value 11995
101 yea, . Calcu1a!lom .

Population In Model Veal 153 920 000 PopulatIOn m Base Vea, 158 980 000

Index Number NHA Model Vear / Baae Year
Nal!Onal CurrenCll(E!Il'plLE) 10 6300

B_.\I8ar (Egppt LE) / 1 US DoDal 13 3500

Baae.\l8ar (ElB'pt LE) / 1 PPP I
Dollar L-.---'

No va!ueset

Values entered ale m OrAsls 0 Thousands (000) @ M!IIIons (DOD DOD) 0 Billions (000 DOD DDO)

Help
~

.IlK I ~ncel--------_..... -------"

The values entered on thiS screen Will be used In the Estimate
Table Graph and Reports Windows to perform currency and per capita
calculations When the Country Profile screen IS first displayed an
astensk ( ) will appear In each of the value fields to indicate that no
value has been set Until you enter thiS data, many ofthe conversion

12



options allowed on the EstImate Table Graph and Reports screens Will
be unavaJiable to you See sectIOn 4 3 Choose Value to DIsplay' for
more mformatlon

If you wIsh to enter this data after you have moved on to other steps
of the project you can access the Country Profile screen from a button
at the top of the Step by Step Menu wmdow or vIa the Country Profile
menu optIon on the FJie menu

For documentatIon purposes you can enter the Country Name
Currency UnIt Name and Model and Base Year fields The Model Year IS
the perIod for whICh you are domg the current NHA analysIs The Base
Year IS a year you select for comparIng the current analysIs agamst some
different perIod or standardIzed numbers from other countrIes It can
be a year eIther before or atter the Model Year These fields WIll help you
Identify this analysIs at a later tIme Values entered m these fields are
not used m any calculatIOns

At the bottom ofthe wmdow IS a set of radIO (optIon) buttons titled
Values entered are m Select one of the four chOIces If you select
MillIons (000 000) all the values entered for flow Will be mterpreted as

bemg m mJilIons of your natIonal currency UnIts

For example If the Currency UnIt IS rubles and the Model Year IS
1995 and the MJilIons button IS selected, a flow value of 56 6 WIll be
mterpreted as meanIng 56 600,000 Rubles In 1995

You can also mput the natIonal populatIOn values for the model and
base years The Values entered are In chOICe and populatIon values are
utilIzed In the per capita calculatIOns

NatIonal Health Accounts provIdes you the optIOn of recalculatmg the
values m the NHA matrIX m U S dollars and Purchasmg Power ParIty dollars
for the year ofyour NHA estImate You can also recalculate values In the
matrIX In terms of a real or base year value for comparIson purposes

PPP dollars are estImated corrected for purchasmg power differences
between countrIes One PPP dollar has approximately the same
purchasmg power In terms of a basket of real goods In different countrIes
For further mformatlOn about the definItIon and constructIOn of PPP
values see Salvatore 1993 and Salazar-Carnllo and Prasada Rao. 1988

Real or base year estImates recalculate the matrIX cells In terms of
the theIr estImated eqUIvalent quantItIes m a prevIOus year that IS
corrected for InflatIon Real value estImates can be obtamed In natIonal
currency U S dollars or PPP dollars

The Country Profile screen lets you mput the approprIate
coeffiCIents for makmg these dIfferent calculatIOns You must determme
the coeffiCients yourself from avaIlable statistIcal data In your country
or from mternatlOnal sources Exchange rates for the year of your NHA
estImate can usually be obtamed from the central bank mInIstry of
finance or a natIOnal economIcs or statIstIcs reference They can also be
obtamed from the World Bank or In edItIOns of the World Development

Ho~ TO USE THE rv4no~4L HE4LTH ACCOL VS PROGR411
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RepOl t or World Economic StatistIcs PPP dollar rates may also be avaIlable
from these sources or from InternatIOnal FmanclGl Statistics published by
the InternatIonal Monetary Fund

In order to use all the currency calculatIOn optIOns you must
provIde the following data

For the Model Year

• U S dollar exchange rate In the model year entered In the form of
NatIonal currencylUS $1

• PPP dollar exchange rate In the model year, entered In the form of
NatIonal currency/PPP$l

For the Real Value calculations

Adjustment coefficIents for estlmatmg base year values are entered
as Index numbers wIth the base year = 1 For example If there was 70
percent mflatlOn In the natIonal currency between the base year (= 1)
and the year of the NHA model, the adjustment coefficIent for natIonal
currency would be 1 7 The program calculates real values as follows
first the real (I e base year) value of the model year natIonal currency
value IS calculated ThiS gIves the natIonal currency base year figure
Then to obtam the U S dollar or the PPP dollar figure, the natIonal
currency base year figure IS diVIded by the U S dollar or PPP dollar
exchange rate for the base year For real value calculatIOns you must
enter the follOWing

NatIOnal currency adjustment coefficIent (as above)

• U S dollar exchange rate In the base year entered m the form of
National currencylUS $1

• PPP dollar exchange rate In the base year, entered In the form of
NatIOnal currency/PPP$l

For more InformatIOn, see the currency and per capita calculatIon
chOICes In the Choose Value to Display Window In section 4 3

3.5 The Step by Step Menu

When you start a new project or select a pre eXisting one the Step
by Step screen IS dIsplayed It also IS shown whenever a project IS open
and no other maIn Window IS displayed

The NatIOnal Health Accounts methodology, each matnx and the
substeps of each matnx WIll be dIscussed In detaIl In Chapters 4 and 5
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The Step by Step Wmdow

III Analyze how Fmancmg Aget1ls dislnbuIe fund~ on Ihe
...... 01F_oIIered by Pr"'-o.

IV Oetermrne how Fmanang AgenI~ allocate._~ 10
diffenng lme Jtemt..-

g.- File. C.\NIIA\EXAMPLE NIIAHelp

NatIonal Health Accounts_ Step by Step

Definee-,f1ofi1e I

v FinaOJ> create addilJonaI ma_ ouch as Fmanang
Aget1ls 10R_ 0' SoaaI Classes 10 Fmancmg Aget1ls
0. other poutbIe ana""'"

II Nelli delemune the1_of .esoure= hom Ihe
Fmancmg Aget1l~10 the ulbmate ProVIders 01 health care
and .eIated goods and semceo.

L Stall,.,... anar,- of Ihe _ d fundo..1he heaIlh care
S1"leIIl_1he Sourceo of funds. TIi''''' Ihe flow hom Ihe
-500•.,.,.10 Ihe Fonancmg Agenlo.

The five buttons on the Step by
Step screen access the five mam
matrices of the National Health

Accounts methodolo~y Chckm~

on one of the buttons Will bnn~

up a wmdow that displays the
substeps of the correspondm~

matnx

3 6 Openm~ a Project File

There are three ways to start an eXistIng project

• Select one lIsted directly on the File menu

• Choose Open on the File menu and see the files that eXist on your
disk or

• Select the Last File or Select a different file options on the
Welcome screen (see above)

3 6 1 The Last Accessed List on the File Menu
Note

NatIOnal Health Accounts records the last four projects on which
you have worked These four projects are lIsted at the bottom of the
File Menu To start one of your eXistIng projects click on Its file name
as listed on the File Menu

When you first use the system no pilar
projects Will be listed

3 6 2 Fmdmf! a Project on Disk

ClIck on the File Menu option and select Open The system will
display a WIndow shOWIng all the project files In your current National
Health Accounts (NHA) directory To select one clIck on Its name and
clIck on the OK button

To look In another directory click on the directory s name Once
Its contents are listed you can select an NHA file to open by clIckIng
on Its name then clIck on the OK button

Note

If you attempt to open a project fIle and you
receive the messa~e ThiS fIle IS not a National
Health Accounts Database the project file may
be corrupted To attempt to reparr It see sectIon
72 Database Compactln~ and Reparr

NATIONAL HEALTH ACCOUNTS 15
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Open National Health Accounts Project Window

filen-. faldeq \ 1'- ~OK -1, IIIlIl!l ...""'" . - z cancei Iexample nha t:5I c \
~nha ~N~k. 1

3.7 The Sample Project: The Ellyptian Health Care
System

ThiS manual uses a sample NatIonal Health Accounts project, the
Egyptian Health Care System to IlIustrate procedures descnbed 10 the
text ThiS file EGYPT NHA IS shipped as part of the mstalIatlOn It has
been mcluded 10 the NHA software as an Illustrative example of how to
apply NatIOnal Health Accounts, and selected wmdows are displayed 10

thiS manual These figures are more fulIy discussed 10 the 1995 report
NatIOnal Health Accounts ofEgypt by the Department of Plannmg of the
Mmlstry of Health and the DDM Project

3.8 SavinI! Data

3 8 1 Automatic Savm~

NatIOnal Health Accounts saves most of your data when you clIck
on the OK, Add, or Remove button on any screen When you open a
detail wmdow either to add a row or edit one, the system will save
your data as soon as you clIck on the OK button ClIckmg on Cancel
Will stop the data from bemg saved to disk

382 SaveAs

NatIOnal Health Accounts also supports the Save As function Save
As allows you to make a copy of your current project ( NHA file) and
contmue work on that copy For mstance, If you want to save your
work 10 the current file and create an extensIOn of your work 10 a
different file clIck on Save As on the File Menu The system wllI ask
you for the name of the new file to create Once you have provided the
name and locatIOn of the new file, NatIOnal Health Accounts Will copy
the file to the new name It Will also close the old file All additIOnal
work will be on the new file until you use the Close Project or Open
Project functIOns

If you want to copy a table's data to a file-for pOSSible use 10 a
word processor or spreadsheet program-see the Export functIOn
descnbed 10 section 6 2

16



3.9 Closml! a Project File

When you Open a project or mltlate the New Project process, any
project you currently have open IS automatICally closed Projects are
also automatically closed when a project file IS compacted or repaired
or when you leave the system See "Database Compactmg and Repair
m sectIOn 7 2 for further mformatlOn on these features

You can close your current project at any time by clIckmg on the
Close Project optIOn on the File Menu Once you close your project
the Welcome to NatIOnal Health Accounts screen Will be displayed

3.10 Leavml! the PrOl!ram

To shut down National Health Accounts take any of the followmg
actIOns

• Double clIck on the Control-menu box-the square m the upper left
corner of the NatIOnal Health Accounts wmdow that looks lIke a
mInUS (-) sign enclosed In a box (In WIndows 95 sIngle clIck on
the X button In the upper fight corner)

• From the File Menu select EXit

• From the Welcome to NatIOnal Health Accounts screen, clIck on the
EXit button

• Close down WIndows Itself (ThiS Will close down all WIndows
programs that are runnIng Never close Wmdows when NatIOnal
Health Accounts IS performmg an actIOn)

You should back up your project ( NHA) files frequently when you
leave the National Health Accounts program IS a good time to do so

3.11 Help

To access help do any of the follOWIng actIOns

• ClIck on the Help button on the Welcome to NatIOnal Health
Accounts screen

• Select the Contents optIOn on the Help Menu or

• ClIck on the Help button located m the lower left on many
WIndows

Halt TO USE THE NATlO\41 HE4lTH ACCOI \75 PROGR41f

Warnmu

We recommend that you always shut down
NatiOnal Health Accounts before turmnq off your
machine Turning off your machine or rebooting
or resenlnq It while National Health Accounts Is
running may damage your current projed Never
turn off your machme while National Health
Accounts IS performing an adlon that causes the
hourglass to show In most cases your projed Will
not be damaqed but caution IS advised In the
event your project cannot be opened see
Database Compadlnq and Repair In Chapter 7

NATIONAl HEAlTH ACCOUNTS 17



Chapter 4

Five Matrices

How to Use the Basic Elements
of National Health Accounts

4.1 MaIO Wmdows

National Health Accounts has four predefined matrIces accessIble
from the Step by Step wmdow The program also allows you to create
addItIOnal matrIces usmg the Other MatrIces feature The five maIO
buttons on the Step by Step screen correspond to the five matrIces

- - -
, ~ - §-

I ; ~Sotlrce$ to
I -1 ~anClng

it ents

t- r Jl'-~-""'~t ~ Flnancrng I
! Agen~to

! t +r P!~;ldet~ -, ,

I f}~~I~~~;;~:
f - Agents to

+tFuncttons

I V'j -Rn~n~I;~ , -
- Agents to

fi=Line lkems -

r- ~-- -=-
- Other,

~ Matllces

t ,Emm

1 Sources to Flnancln~ A~ents

2 Flnancln~ A~ents to Providers

3 Flnanc,"~ A~ents to Functions

4 FlnanCln~ ~ents to Une Items

5 Other Matnces
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Once you have entered one matrIX by clIckmg on the correspondmg
button the MatrIX Steps wmdow wIll be dIsplayed for that matrIX The
other matrIces WIll be dIsplayed as file tabs The user can SWItch
between matrIces by clIckmg on the tabs

On the MatrIX Steps screen, each matrIX has a serIes of substeps
assocIated with It For example, If you press the first button, Sources to
Fmancmg Agents, a serIes of substep buttons are dIsplayed that gUIde
you through the constructIOn of the Sources to Fmancmg Agents
estImate matrIX and assocIated tasks



Matrix Steps Wmdow

HOH; TO USE THE 845/C ElH1E~T5OF NAnO~41 HE4lTH 4CCOUNT>

The structure of the serIes of substeps IS IdentICal for each matrIX
and follows thIs order

DetaIl of Matrix Steps Wmdow

When you clIck on one of these buttons the window assocIated
wIth the function WIll appear on top of your main National Health
Accounts Window

Once you have entered a partIcular substep you can move back
and forth between substeps by clicking on the Next and PrevIous step
buttons at the bottom of the respectIve Window There IS no need to
eXit out to the inItIal substep lIst again

If you WIsh to change the order of the steps you can do so vIa the
Settings Window See sectIOn 7 1 for more informatIon on the Settings
Window

j~,,'l:I~ ~f- ~T-'i "~,, Detai18d Flow DIagram

,j S 7:;;Ao=gr~3
fI @ Estnnale-Matnx ¥ ~ ~I
'rffi Graph;":'~ -""'......:. --=1'
F~- M~itar Grap~-:.~1

,,(' - "'.... _ rr---,..

3 Detailed Flow Diagram

4 Full Flow Dla~ram

5 Estimate MatriX

6 Graphs

7 MatriX Bar Graph

8 Checks and Reports

Trackml! Your Prol!ress throUl!h
National Health Accounts

The small white boxes to the left of the substep
descnptlons on the MatriX Steps screen allow you
to check off tasks you have already completed
These check off options are also shown on the
ProQress Checklist Window The ProQress Checklist
can be accessed via the GUide menu on the
Welcome Window's menu bar You can check off
sections In both Windows Two other selections
on the GUide menu Next and PrevIous can help
you move automatically to the next step In the
methodoloQy
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4.2 A Tour throus:!h the NHA Methodolol!Y
This section of the manual Will take you on a brIef tour through the

substeps of the program USIng the first matrIX Sources to FInanCIng
Agents, as an Illustrative example

The completion of the Sources to FInanCIng Agents analysIs IS a
prereqUIsIte to the remaInder of the matrIces, which rely on the
allocations the analyst has made to the finanCIng agents In thiS first
matrIX As was mentIOned In Chapter 1, the funds mobilized In the
health sector do not pass directly from the prImary sources to their final
uses Instead, much of the money first passes through financial
IntermediarIes known as finanCIng agents In the NHA software whICh In
turn transfer resources to the ultimate proViders of care ThIS
Intermediate category of payer allows for the separation of finanCIng and
provIsion of health care services In some cases, however sources and
finanCIng agents may be Identical ThiS would be true In the case of
households and firms that pass much, If not most ofthelr expenditures
directly to the ultImate proVIders of care In these cases, households and
firms appear as "virtual' finanCIng agents In the NHA analysis-not
formally constituted as a finanCIng agent but still representIng a fundIng
pass-through

For all sources of fundIng, money IS transferred to more than one
financial Intermediary and proVider These InterrelatIOnships are eaSily
Visualized through the flow of funds diagram that IS constructed In
substeps 2 through 4 on the follOWIng pages
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4 2 1 Substep 1 Choose Entity Al!ents

Substep 1 Choose Entities for Matnx

x

S.UlceS
I-E_--,--------.--~

Chonte from lid 1 Add ~ J
r.-Fo=,e-':--gn""'A-cd---===; Ii::HousehokbII~':='''''-:''¥''~_"...----------ill
H h Id 1_,onaIAod
..tin st }I of Fn N of-Fmance
Pnvately Owned F m
Sf 1 Ow d F m

Defmes the entities
Involved m this matrix

(I EaEr8Ie;

••finanCIng Agents
Chonte from r... j Add ~ I
ruH:'::u""i:"hi'i'ld:..:c:..:.._--"===="1 F.H=_=Icb=;fn_=;-::=::;~_--=,"""=_"",-_
N n try of Edue Ion Insmance Pnvate .......
hi t.p f F nance lmurance: SoaaI ....
MInistry of Health IntamabonalArd
~lhe~MI 1m laJ H Ith 5 v .. Nmmne: Other
"'-"""-=~---- N olE_
Dr enter below- I Add JF.;NC"",~by"-'ol""'Fi;=:onance==--------

;;...==c::=__-===;, I ~ Remove I

I Sort E_.. by N....

~ IrDer.,._J

You use the Choose EntItIes WIndow to define the source and
destInation entities for a gIven matrIX In the Sources to FInanCIng
Agents matrIX you must first define the sources and the finanCIng
agents To enumerate sources you can choose from the lIst of sources
bUilt Into the program or add your own source categorIes Your chOIces
then appear on the Sources lIst that appears on the rIght SIde of the
WIndow

To add a source from the lIst of choIces preloaded wIth the software
clIck on the Item you wIsh to add In the Sources lIst box Then clIck on
the Add button above the lIst box To add an entry not on the lIst enter
the entIty name In the edIt box and clIck on the Add button above the
edit box

When addIng your own source category or edItIng a source entity
already lIsted by clIckIng on the Edit EntItIes button the EdIt Entity
WIndow WIll come up The EdIt EntIty WIndow allows you to choose an
abbrevIation for the entIty enter ItS total amount as a source and
deSIgnate the sector (government publIc sector or prIvate sector) of the
entIty The abbreVIatIOn IS used In the graphs and dIagrams to represent
the entIty It IS best to enter a recognIzable abbreViatIOn for the entity
The categories government and publIc sector are not mutually exclUSIve
so the user should refer to the definItIons In the glossary (see publIc
expenditure on health )

Choose the entities for finanCIng agents In the same manner
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Edit Entity Wmdow

.. E~II Entity £i

o Public Sector 0 Pnvate Sector

Enbty Name IOther Mlnlstnes

EntJt, Abbore¥Jabon. l..-IO_'h_M_'ns__-----'

En"IJlTotaIA""S'.:.::r;:c155~O~O-----'

[

SectOI

@ Government

Custom Order c=:J

22

!!.K

The panel also allows you to designate a ' custom order" value for
thIS entity You can use the EntIty Order optIOn m the Settmgs box to
cause many of the lists and dIsplays m National Health Accounts to
dIsplay m the order you desIgnate ThIS IS dIscussed further In the
section on Settmgs' In section 7 1

The Entity Total Amount field can be used to validate the total flows
entered Later In the process (substep 5) you can use the Details for
(Entity) wmdow accessIble from the EstImate Matnx Window to compare
a sum of the flows to or from thiS entIty With the EntIty Total you enter
here Use the InconsIstent Values Report (m substep 8 Checks and
Reports) to do a global comparISon of all flows wIth totals entered on
thIS Window

In the Egypt example sources Included all those listed In the default
IIstmg plus pnvate msurers and a sOCIal msurance agency In addItIon
the default IIstmgs were modIfied to correspond to the source
termmology as used m Egypt
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4 2 2 Substep 2 Define Flow

Substep 2 Define Flow

Trace the flow of resources from Employers

Triice the Flew hem _ SauTee t. Finiincln, A!!!!Ients: EJ,Defines the flow between entities by
seledln~ who received resources from
whom

Remauung pouibIe Fmancmg
Agents

To the foil_ list of Fmancmg
- Agents

Households/IndivIduals
Intemahonal A,d
Mlnlstnes Other
MlnlstTV of Educallon
Mlnlstr, of Finance
Mln,stry of Health
Ministry of SOCial Affairs

- f :'1-- Films Private
. Insurance PJlvate

- Insurance SOCial

I,

l .... ll~j
II Nelll .....

IL---~-----",..,,--,.,.--J' -

~-

I< Prev!ou> II Add Enbbes oF

I ? Help 'l~< Enbbes III'" DetDISg. , I • Close J

In thIS substep you can trace the flow of resources from a smgle
source to vanous financmg agents You can choose multIple financmg
agents from the lIst of financmg agents that you IdentIfied m the
Choose EntItIes screen The screen also allows you to remove financmg
agents entered by mIstake

You must fill out a separate screen for each source You can SWItch
between the sources by clICkmg on the PrevIous or Next buttons,
located on eIther SIde of the Add EntItIes button

If you have not filled out the Choose EntItIes form you can return
to It by cllCkmg on the Add EntItIes button Return to the Choose EntItIes
wmdow If you need to add an additIOnal source or financmg agent

NATIONAL HEALTH AccouNT.5
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4 2 3 Substep 3 Detail Flow Dla~ram

Substep 3 Detail Flow DlaQram for Entity

USIn~ a ~raphlcal display defines
the flow between entities by
seledln~ who received resources
from whom

Deta1.1 D1ag::z:am SOlD:ces to F1nanc1ng Ag"ent
fo:r Ent1ty Employexs

SOUJ:ces

F1nanc1ng Agents

AddFiows - I

IB Pmt ICi]i;l

This screen graphically displays the 1Oformatlon you entered 10
substep 2 As 10 substep 2 you can move between each source entity
by clIck10g on the PrevIous Entity or Next Entity buttons at the bottom
of the screen

If you wish to add more flows from a s10gle entity directly click on
the Add Flows button located 10 the lower rIght corner of the screen
The program WIll prompt you to clIck on the 'from' (top) entity to
select the source of the flow In the case of the Egypt example If we
had forgotten to show the flow offunds between foreign aid and the
M10lstry of Health we could add the flow as deSCrIbed above

Then the program Will prompt you to clIck on the entity the flow IS
to The program then automatically draws a lIne representmg flow of

funds from the source entity to the financ10g agent entity selected
Once you are done add10g flows, clIck on the Stop Add10g Flows
button 10 the lower rIght corner of the screen

The Add Flows screen also allows you to remove flows If you have
made a mistake or Wish to vIew the graphiC and matrIX WIthout thiS
particular flow ClIck on the Delete Flows button located 10 the bottom
rIght of the graphIC display

Later when you have entered data for the other matrIces you can
use the Detailed Flow Diagram w1Odow to view the flows from two
lInked matrIces via the Show 2 MatrIces button For example you
could view the flows from sources through financmg agents to proViders
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4 2 4 Substep 4 Full Flow DlaS1ram

Substep 4 Full Flow DlaQram

Displays the flow between entities
by seledm~ who receives
resources from whom

F~ D1aq:t:arn Sow:ces to Fl.nanc1ng Aqents

S01D:ces

F1nanC1ng- Agents

! - -'-... - "'" -- -......... ..... ~-

~MatrOf - t - ";f.;M~ ~ ""t~how"'2i~~ I~:::~::- _-'~-'"='::M1~ ::d-t
..-_r--__ .....,.. -~____._.r~ -_......... -~ _...., .... ~ _-.o__.-,..~ ... ~-..,.... .......... w

I ?Help ll«DelDlOl;.fII""E,l.....d - -- -"IBFmt II .0-1

ThIS step graphically summanzes the flow offunds detaIl entered In
substep 3 All sources are shown wIth theIr lInks to the finanCIng
agents The program allows you to add addItIOnal flows USIng the Add
Flows button or remove flows USIng the Delete Flows button USIng the
same procedure descnbed In substep 3

The buttons PrevIOus Matnx and Next Matnx allow you to go back
and forth between the vanous matnces you have constructed

You can sWitch between the Full and Detailed Flow by chckmg on
the Detail Diagram button ThIS may help you disentangle the flows If
there are many entities and many flows defined See substep 3 for
Information on the Show 2 Matnces feature
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4 2 5 Substep 5 Estimate Matnx

Substep 5 Estimate Matnx

Assl~ns detailed values to the
flows between the entities In the
matrix

"¥MH5:ew , iiii44ih4!.fl.lg;.1 w; xl
add Entitles I Soulces

'·""'''IIIJIAgenl&
EIIlIlI_ "-- 1n/.m.II".... -M-,ool TOTAlAid .......,..- -rIms Pllvale -=-_-2J!,MJ 7000

Households: 2.304 00 230400
Insurance Pnvate 2000 1000 3000
Insurance Social 277 00 9300 37000
InternatIOnal Aid 5100 5100
~hmstnes nthet 10000 10000
Mmtshy of Education 270 00 27000
Mlnlstrjl of Finance 18200 18200
MinIStry of Health 13500 64700 78200
MInistry of SOCial 700 700
TOTAL 36700 - 240700 lB600 120600 416600

-- III Q100seValue to DlsPfay JI gUlck Entry I lleiln.FIow

Dl pla,YlfIg Amount as Entered In Natlonall.Ulrency (Value In 000 OOOs) Bow Deteil (C.nl I
~I Full Dlag. 1Ir Graphs 1 IBPnnI I~

The estimate matriX IS the heart of the NHA methodology The first
two predefined matrices, Sources to FlOanclOg Agents and FlOanclOg
Agents to Providers, comprise the full "sources to uses' matriX that
make the NHA methodology most useful to pollcymakers

The estimate matrix that shows expenditure flows from sources to
financlOg agents IS two-dimensIOnal On the hOrizontal aXIs all
ultimate sources of financlOg appear These sources are drawn from the
lOformatlOn mput dUring substep 1 On the vertical aXIs all financmg
agents are listed All expenditures estimated by the different sources
must be allocated to speCific financmg agents smce the totals and
subtotals must add up and be consistent

The estimate matrix can also display values that are the result of a
series of calculatIOns Calculations mclude currency conversions
adjustments for lOflatlOn, percent values, and per capita values Click
on the Choose Values to Display button to apply these calculations See
the tOpICS lo the "Choose Values to Display section, below and The
Country Profile section lo Chapter 3

To enter data lOto a cell simply double click on the cell or select
the cell and click on the Flow Detail (Cell) button The Flow Detail pop
up Will appear The Flow Detail screen traces the flow of resources from
a particular source to a particular financmg agent for example from
households to prIvate msurance (see further diSCUSSion and Image below)

If you Wish to enter all estimates at once Without filling 10 all the
1Oformatlon lo the Flow Detail pane click on the QUIck Entry button 10

the center of the wlOdow The MatriX QUIck Entry pane functIOns like a
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spreadsheet Data can be entered by posltlOnmg the cursor 10 each cell
and typmg 10 the values Chck on OK when you are fimshed entenng
the data If you do not chck on OK the mformatlon will not be saved

Flow Detail Wmdow
x

flowhom HogsehQJds1Jntfnnduols 1Q In8Vrom;g pnyme I Jt.~

For those usmg the program to gam a better understandmg of how
NHA works It IS best to go through the Flow DetaIl screens for each
flow rather than gomg directly to QUICk Entry The Flow DetaIl screen
allows the analyst to document the mformatIOn sources that fed mto
the estimate and assocIate a scale of rehabliity wIth that estImate The
list of mformatlOn sources theIr rehabliity and any comments you may
have made can be prmted from substep 8 Checks and Reports The
relIablhty scale weIghts an estimate accord109 to whether the quahty of
the estimate corresponds to the qualIty you mIght expect from audIted
accounts or whether the estImate IS acceptable or unacceptable (see
glossary for more detaIl)

In addItIon the screen shows the breakdown of total source
spend109 through the dIsplay of the other defined cells The analyst
should also note If the flow demands further research by clIckmg 10 the
small whIte box Needs further research You can move among cells by
eIther cllckmg on each new cell directly or clIckmg on the PrevIous and
Next buttons at the bottom center ofthe Flow DetaIl screen

If you WIsh to add addItIOnal entIties from the Estimate Matnx
screen SImply chck on the Add EntIties button 10 the upper left corner
of the pop up to return to the Choose EntItIes screen (substep 1) If you
WIsh to define addItIOnal flows offunds, clIck on the Define Flow
button to return to the Trace the Flow screen (substep 2)

You may have a long lIst of sources and all the columns may not be
displayed on your momtor at the same tIme If thIs IS the case you can
scroll left and nght by clIckmg on the arrows at either end of the
column senes

How TO USE TIlE BASIC ELEME/I/T5 or !V4nO\AI HE4lTII ACCOI"'ff'

NOTE

In substep 1 Choose Entities you desl~nated

a total amount to each source In thiS substep
you are allocatln~ thiS total source amount
amon!lst the various flnancln~ a~ents

Theoretically the amounts allocated amon~ the
fmanclnl:! al:!ents should sum to the total amount
listed for each source However because NHA
estimates can be calculated m different ways the
pro!lram allows for discrepancies between the
totals and the summed allocated amounts
attributable to a partICular source For example
total household spendln~ on health care services
could be estimated either from the revenues of
health care prOViders or from surveys of
households themselves Data on pharmacy sales
and user fees at !lovernment and public faCIlities
may also feed Into the construction of NHA
estimates of household spendm~ The analyst Will
seled an mformatlon source or a combmatlOn of
Information sources dependlnQ on the sources
perceived reliability If there IS a discrepancy this
Will be reported In the Consistency Check report
desCflbed m substep 8 Checks and Reports The
analyst can then deCide how to adjUst the estimate
such that It balances With the remainder of the
prepared estimates either throuQh modlfymQ the
reported total (from the Choose Entities Window)
or toleratm~ a certain de~ree of Inconsistency
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To compare the program-generated total of flows for a given Item
with the smgle value you may have entered m the Add Entity or Edit
Entity wmdows double click on the total highlighted (m yellow on the
screen) for an entity The Details for (Entity) wmdow will be displayed

Details For (Entity) Wmdow

Name International AId
Amount on Fde 186 00 TlIbIe Total 1861lO
Table Total all a percent of stored amount 100 '00

I Close' I

This wmdow compares the smgle value associated with an entity
with the total of all flows to and from that entity The Amount on File
value IS the value entered on the Edit Entity wmdow The Table Total IS
the total you clicked on to reach this wmdow from the Estimate Matnx
wmdow The bar at the bottom ofthe wmdow compares the two
values showmg (up to 100 percent) the percent value that the Estimate
Matnx total value makes up of the Edit Entity value
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4 2 6 Substep 6 Graphs

Substep 6 Graphs

Displays graphs of the flows
between entities

.. Grill~h: S.urces t. Flntimcin!l A!!!Icnb ~

Sources

2500

2000

1500

1000
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J;hooseValue 10 DISPlaY

The Graph button on the substep menu WIll display the matrix
estImates m a graph The program WIll display nothmg here If there are
no estImates entered m the estImate matrix m substep 5 The first
graph WIll plot the expenditure estimates of all of the sources for whom
you have entered data

If you chck on the Other AxIS button m the center ofthe button bar
under the Graph pop up the program WIll show you the matnx estImates
for each of the financmg agents for whom you have entered data

This same mformation can also be displayed m the form of a pie
chart by chckmg on the PIe button

The Graph can also dIsplay values that are the result of a series of
calculatIons CalculatIons mclude currency conversIOns adjustments for
mflatlon percent values and per capIta values Chck on the Choose
Values to Display button to apply these calculatIons See the Choose
Values to DIsplay wmdow (section 4 3) and the Country Profile wmdow
(sectlon 3 4 )

NATIONAL HEALTH ACCOUNTS 29



How, TO USE THE 84SIC ELEMENTS or N4TION4L HE4LTH ACCOUNTS

42 7 Substep 7 Matrix Bar Graph

Substep 7 Matnx Bar Graph

Displays a graph showing
the flows apportIoned
between the sources and
receivers

IIatr1x Bar Graph Souroes to F1nanc1ng Agents

Sources

Other
_lOyel

x

Fl.nanc1ng' Agents

I ? Help I 1« Graph> II t"CbecklReptl

In thiS substep, Matnx Bar Graph the program displays the data
you entered In substep 5, EstImate Matnx In honzontal bars that
represent the relatIve share of expenditures that are dIsbursed and
received
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4 2 8 Substep 8 Checks and Reports

Substep 8 Checks and Repons

Validates matrices and views and
prints a vanety of reports ~

r Consmency Check. A.., the IIows 01 ....""""'. m -..ces wluch have FJl>llf1CIfl!l Agent.... IflI'UI
cormolenl WIIh the !low. m So..ceo 10 Fmancmg Agents?

rMalnces 10 CoYBf m Check.

I
1/lII malnceo will be checked.and output will be-- as D"'POft when the eunenl
malmt •• the Sowceo to FJl>llf1CIfl!l Agento-J

TulBfance lnlesval (Pefcent): ~(9950 10 100 501

I
Incomplete Entnes In Matnx Report
Flow Detad Report
Source Report for all Malnces
Enl11u ReoOTt for alllwlatnces

B.!mm!;.

Maino 10 be CoYefed bl'Report:

Financing Agents 10 ProvIders
Financing Agents 10 Functions
Financing Agents 10 Line lIems:
FlnanclnQ AQents to Re Ions

-...
IL Run!!.epoJI J

Expot!Oata
E-"Data 10 Spteadoheel P"'!l'amo m Comma-Sepmated Value fonoat: _......;;;gp-,--ort_O_Dta_--,

I ? Help 1/< MalGraph I

The purpose of the Checks and Reports wmdow IS to allow you to
review and analyze the data you have entered earlier m the process The
window IS divided Into three areas Checks Reports and Export Data

The checks section of the Checks and Reports screen allows you to
run a consIstency check Within your current matrix or across all the
matrices for whICh you have data The check produces an InconSistent
Values Report that can be printed or exported to another application

The consistency check verifies that all the data entered sums by row
and column Running the check compares the totals In your current
matrix to the totals you entered In the Edit Entities Window Runnmg
the check across all completed matrices compares totals In the current
matrix to the totals In all other matrices and the totals entered In the
Edit EntIties wmdow The check Will report discrepanCIes Within a given
tolerance Interval which the user can modify dependmg on their data
The default value for the tolerance Interval IS 50 percent This means
that the program Will search for any estimates that are over 50 percent
greater or smaller than the comparable estimate This flexibility allows
the user to Include estimates that are not consistent With one another
WIthin a certain range but It also highlights problematiC estimates
Ultimately the analyst Will want to reconcile these estimates In that
case the analyst should have zero tolerance for dIscrepanCies and fill In
a zero In the tolerance mterval blank

The Reports sectIOn the mIddle section of the Checks and Reports
screen allows you to print any of the estImate matrices for which you
have data The Estimate Table Report Will show data for up to SIX of the
from entities for the matrix and all the to entities First you must

• IJose
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select the EstImate Table (GrId) Report for a matrIX from the Report lIst
by clIckmg on It once Second you should select the partIcular matrIX
you wIsh to vIew from the MatrIces Covered by Report lIst ClIck on
Run Report button to dIsplay the Select Columns for Report wmdow
You can choose the specific "from" entItIes (up to SIX) or select a group
comprIsmg the first SIX, second SIX and so on vIa the Choose a set of
SIX columns optIOn

Select Columns for Report Wmdow

Select Particular Columns OJ Set of Columns
I'i Choose columns. from the follOWing list

r Choose a set of SIX columns

r Print all columns:

Choose Values to-';:;spla;:;e;o~t~- ~ I~

DisplaYing Amount as Entered In National Currency (Value In 000 ODDs)

IX Show Declmah:

!!.K ~ancel

The EstImate Table report can also prInt values that are the result
of a serIes of calculatIons Calculations mclude currency conversIons
adjustments for InflatIOn, percent values and per capita values Click
on the Choose Values to DIsplay button to apply these calculatIons See
the tOpICS on Choose Values to DIsplay wmdow (section 4 3) and
Country Profile wmdow (section 4 3)

Selection Cnterla for the Incomplete Matrix Report Wmdow

The MISSing Data Report will select cells In the selected
matrices whIch meet the follOWing criteria

IX The estimate IS marked as unacceptable

IX The value 01 the cell IS 0

IX The Needs Further Research box IS checked for the cell

r No source for the cell was provided

~ancel
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The Reports section also allows you to run a report on any
mcomplete entnes that might be left m your estimate matnx ClIck on
the Incomplete Entnes m Matnx Report under the Report lIst and then
chck on the Run Report button After you have chcked on Run Report a
pop up Will appear that Will prompt you to define the selectIon cntena
for the report ThIS screen Will select only those cells that meet the
cntena you have selected

A third report the Flow Detail Report presents a complete hstmg
of all the flows m the selected matnx You can use thiS report to review
all the data you have entered mto the program

The Checks and Reports screen also allows you to export data to
spreadsheet programs More mformatlon on thIS functIOn can be
found m Chapter 6 InformatIOn on usmg the Reports wmdow also IS
discussed m Chapter 6

4.3 The Choose Value to Display Window

On the Estimates Table and Graph wmdows and for certam reports
National Health Accounts allows you to dIsplay your values adjusted on
the basIs of per capIta mflatlOn and comparative value calculatIons
Where thiS feature IS offered you WIll see a button titled Choose Value
to Display When you chck on thIS button the Choose Value wmdow
will be displayed

The chOice you make on the Choose Value to Display wmdow
applIes only to the current sessIOn or prmted report-It does not
change any of the values stored m your model Your chOIce on thiS
screen Will be displayed m the legend on the screen or report and Will
remam m effect for all apphcable wmdows until yOll close the project
or program or change the settmg

Choose Value to display wmdow

HoI'. TO USE THE 84S/C E/EWE\!'> or N4nO'-41 HE4/TH ACCOLNn
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CalculatIOns are based on values entered 10 the Country Profile
screen If necessary coeffiCIents are not yet provided the chOices Will
not be available and the buttons Will be disabled on the Choose Values
screen You can access the Country Profile screen from the Step by Step
Menu screen or via the Country Profile optIOn on the FIle Menu See
sectIOn 3 4 . The Country Profile Screen" for more mformatton

Based on the mput m the Country Profile screen you can obtam
the followmg recalculated values for the NHA matriX

• US$ for the estimate year = natIOnal currency m estimate yearlUS$
exchange rate m the estimate year

• PPP$ for the estimate year = natIOnal currency m the estimate
year/PPP$ exchange rate m the estimate year

• NatIOnal currency quantities for the base year = natIOnal currency
m the estimate year/ Index number relative to the base year
national currency value

• US$ quantities for the base year = natIOnal currency estimate for
the Base YearlUS$ exchange rate for the Base YeQl

• PPP$ quantities for the base year = national currency estimate for
the Base YeQ/ /PPP$ exchange rate for the Base Year

Many of these values can also be calculated on a per capita baSIS (If
you have entered the necessary populatIOn values for model and base
years on the Country Profile screen) The per capita calculations also
mvolve the UnIts multlpher, so make sure that the values per capita are
m the correct value UnIts

Example Per capita CalculatIOns

Here IS an example of a per capita calculation based on the current US$ mdex value

For the followm~ information

• A flow value of 47510 (a cellm the Estimates Table)

• Values m thousands (ODDs) (Value units entered on the Country Profile screen)

• US$ exchan~e rate of 1 5 (entered for the proJed on the Country Profile screen)

• Current year population of 26000000 (on the Country Profile screen)

thiS calculation would be performed

• Displayed value ((flow value value Units) / US$ Index) / population or 1 218 ((47510 1 000)/1 5)/26000000

Values can also be displayed 10 terms of the percentage they make
up of the row or column they are m or the total of all cells Percent of
values cannot be displayed m per capita terms When a Percent of
option IS selected, the row and column totals display the values not
percent values
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I-. Close

1~i;1

I~;... flem~~- ~1

There are several buttons that appear on many NHA screens They
Include

Help Displays help text for National Health Accounts This button
IS located In the bottom nght corner of every substep screen In the
program The help text IS based on thiS manual

Add Initiates the addition of a row to one of the mam tables ThiS
button IS enabled only on the Choose Entities and Define Flows screens

Remove Removes entities from lists m the Choose Entities Define
Flows and/or Estimate MatriX screens [f the Item to be removed
Includes a substantial amount of data, you Will be prompted to confirm
the deletion

Prmt matrlX or graphIc For graphs a wmdow IS displayed
provldmg a variety of options (see PrIntmg Graphs m Chapter 6) For
matnx diagrams the prmt wmdow Invokes a screen prmt to your
default Wmdows prmter

Close Close the current main wmdow When all the mam wmdows
are closed the Step by Step screen Will be displayed

4.5 Other Windows

[n addItIOn to each substep wmdow there are a variety of other
Windows They mclude wmdows assoCiated with the Tools menu
optIOn and prmtmg savmg and exportmg data (see Chapters 6 and 7)

In some cases the system may ask you a question or deliver a
short message m a small wmdow Message wmdows are used
throughout National Health Accounts to alert you to errors or to
request confirmation for an action that has significant consequences
Simple messages have only an OK button whereas confirmations have
OK or Cancel In most cases Cancel Will return the system to the state
It was prior to Inltlatmg the actIOn

See also sectIOn 7 1 Settmgs The Settmgs wmdow allows you to
make certam chOICes that affect all analyses you perform With NatIOnal
Health Accounts

1- , -
Help
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~Sourcesto
f... Financing

, Agents:

FinancIng
.r Agel'lts to+ ProvIders

How to Use Other Matrices of
National Health Accounts

In additIOn to the Sources to Financing Agents matriX the NHA
methodology compnses three other predefined matrices From the
financing agents, funds can be allocated In a variety of ways (or' uses"),
depending on avaIlable information

5 1 Matrix II: Fmancml! Al!ents to Providers

The FinanCing Agents to ProVIders matriX IS the most common
"uses" breakdown of NHA used In developing countries to date
Combined with the Sources to FInancmg Agents matriX It produces a
complete pICture of a natIOnal health care finanCing system EstImates
on the allocation of funds from finanCing agents to proVIders are
reasonably easy to determine from government budgets, household
surveys and other admmlstratlve records QualIty may vary from
country to country, but, In most cases, reasonable estImates can be
generated

The substeps assOCIated wIth the FInancmg Agents to ProVIders
matriX are IdentIcal to those assoCIated with Sources to Fmancmg
Agents wIth the exceptIOn that the entItIes to be used as 'provIders'
must be defined A lIst of pOSSIble proVIders IS proVIded m the sectIOn
The Eight Substeps of the NHA AnalysIs, m Chapter 1

5.2 Matnx III: Fmancml! Al!ents to Functions

Allocating funds m the matriX FmancIng Agents to FunctIOns IS a
greater challenge for the analyst but It can be extremely useful for
polIcymakers FunctIOns may mclude mpatlent and outpatient treatment
of Illness, personal preventIve care and/or populatIOn-based publIc
health functIOns

A sub analySIS mIght trace the sector finanCing of partIcular functions
of Interest such as famIly planmng or maternal and chIld health These data
are sometImes dIfficult to collect, even where pOSSible to collect them, It
may be dIfficult to ensure consistency between estImates generated m
other matrIces and those allocated to a particular functIon For example
one mIght rely on prevIously conducted studies of time use m faCIlItIes that
JOintly supply famIly plannmg and maternal and child health programs to
estimate the relatIve share of expendIture assOCIated WIth each program
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Further demand side estimates ofthese expenditures for example from
household surveys are unlIkely to be consistent with these supply side
estimates The substeps are Identical to those of other matnces

5.3 MatriX IV FmancmJ! AJ!ents to Lme Items

LIne Items such as salanes drugs eqUIpment and/or capital
Investment represent another potential uses analysIs withIn the NHA
framework WithIn mlnlstnes of health expenditures by lIne Item may
be relatively straightforward to assess However thiS Information IS
difficult to collect In the private sector and may require a special study
The substeps m these WIndows are Identical to other matrices

5.4 Matrix V: Other Matrices

An NHA analysIs can Incorporate a number of other matnces such
as FmancIng Agents to Regions Fmancmg Agents to Age Groups or
other measures of the eqUity offinancmg dlstnbutIOn The software
allows you to Include matnces relevant to the policy SituatIOn

In order to add a matrix click on the Other Matrices tab at the top
right corner of the MatriX Steps screen An empty table Will appear
Click on the Select MatriX button In the top right corner of the tab
screen The program prompts you to choose a matrix by clickIng on
one of the matrices listed or to add a new matrix by clickmg on the
New MatriX button [fyou wish to deselect a matrix click on the
Unselect button

If you deCIde to add a matrix the Add MatriX wmdow Will prompt
you for the matnx name and the from and to' axes The WIndow asks
that you enter the plural form (for example RegIOns) and the smgular
form (Region) of the word for entIties on that aXIs When you are done
click on OK [fyou deCIde to eXit, click on Cancel

Once you have determmed which matrix you will construct the
substeps are Identical to those outlmed In section 4 2 A Tour through
the NHA Methodology

Add Matnx Wmdow

FinanCing
L Agents to

I = Line Items.-

Other
Matnces

mm

7

....... IoI"bix m

NablllName II

FromAxn Name (Top). To Axn Name {Left)

~~I: ~:I: ~ISmguiar I

.11K !;.ancel
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Chapter 6

How to Print and Export Information

6.1 Prmtmf!

Note

The current version of the National Health
Accounts does not allow the prlntlnq of all data
If necessary you may be able to use the Copy
and Paste commands to transfer thIS data (via the
Windows Clipboard) to a word processmll program
or to the Microsoft Windows Pamt and Paintbrush
accessones

NatIonal Health Accounts allows you to pnnt out a set of reports for
the data that you have entered The prInt functIOn can be accessed
directly from the vanous substep WIndows or from the Reports screen
(substep 8) by clIckIng on the PrInt Icon Reports that are available to
prInt are lIsted In their entirety In the Matnx to be Covered by Report
lIst In the Checks and Reports screen All graphics can be pnnted
directly from the screen

6 1 1 To access the pnntln~ optIOns

To pnnt the currently displayed maIn WIndow, chck on the Pnnt
button at the bottom of each screen or select PrInt from the MaIn
Toolbar A graph must be the currently dIsplayed In the maIn WIndow In
order to be prInted

6 1 2 Report Print Preview Window

Once you chck on the OK button on the PnntIng WIndow the
system Will display the Report PrInt Preview WIndow ThiS WIndow
allows you to browse your report before you pnnt It To prInt the report
from the Report PrInt Preview WIndow, clIck on the PrInt button

Report Prmt Preview Window

1 f1
le'x'

100%
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- Flow Detail Report
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When the Report Print Preview window IS displayed no optIOn
other than Help can be accessed To return to the Main Menu and to
enable other optIOns close the Report Print Preview window by
clICking on the Close Report Prmt Preview button on the toolbar

(As for most wmdows clicking on the Maximize button-the up
arrow m the upper nght corner ofthe wmdow-wlll cause the Window
to expand to fill the display To close any wmdow click twice on the
Control-menu Box-the square In the upper left corner of the Window
which looks like a minus [-I sign enclosed In a box)

6 1 3 Report Print Preview toolbar

Toolbar

II]]]] 1 of 1 IIIElI CancelI~IjH!II~IClose1 11of11 Total 11]

The buttons on the Report Pnnt Preview toolbar allow you to

• Move forward and backward In the display of the report

• Halt execution of report generation

• Zoom In and out on the view of the report

• Export In a vanety of popular formats

• Prmt the report

• In some cases export the report to electroniC mall

(Numenc values between the Next and PrevIOus buttons indicate
whICh page IS being dIsplayed In the Window The numenc values at
the far nght indIcate the number of records covered by the report)

MOVing forward and backward m the display (If the report IS a
Single page report these buttons Will not be actIVe)

Frrst Page Move to the first page of the report

Prevrous Page Move to the prevIous page of the report

Next Page Move to the next page of the report

Last Page Move to the last page of the report

Cancel Cancel ExecutIon If the system IS stIll bUlldmg the report
cllckmg once on thIS button will halt further construction of the report
The portion of the report whIch has already been bUilt WIll be displayed

Zoom ZoomlFull-Page Clicking on thIS button WIll cause the preview
display to toggle between different levels of resolutIOn of dIsplay

ICancel]

MlTIONAI HEAIT1f ACCOUNTS

39



How TO PRINT 4ND EXPORT INfORMA170N

40

Destmatlon Options

Prrnt Pnnt the report

Export to ElectronIC Marl Due to the vanatlon m electronic mall
systems, this button IS not automatICally enabled dunng installation If
enabled, depending on the nature of your electronic mall system and/
or Internal network, this button may allow you to send your reports to
others via electroniC mall

6 1 4 PrmtmQ Graphs

Graphs can be printed to one of four destinations

• Prrnter The Pnnter option Will print a graphical representatIOn of
what IS displayed on the screen, mmus the toolbar and menus

• Bitmap file ThiS option Will create a Windows BMP file containing
the screen Image When you choose the Bitmap option, the system
Will ask you for the name of a file to store the data on disk Many
Windows word processors Will allow you to Include the BMP file as
a picture In documents Graphical programs such as Microsoft
Pamtbrush can be used to edit or change the Image

• Wrndows Metafiles ThiS optIOn Will create a WMF file contamIng
the screen Image When you choose the Windows Metafile option
the system Will ask you for the name of a file to store the data on
disk Some products such as PowerpoInt Will allow you to Include
the WMF file as a picture m documents WMF files are more
compact and faster for programs to draw than Bitmap files

• Clipboard Usmg the Clipboard optIOn Will place a copy of the
Image In memory Most other Wmdows applicatIOns that support
Images can then be used to Paste the Image directly Into
documents or other pictures

For all destinatIOns, If scroll bars are shown on the graph, there are
more entities than can be prmted on a Single Image In thiS case, after
prInting the first Image, scroll down and pnnt for any additional entities

6 1 6 PnntmQ Matnx DlaQrams

The Diagram Print Preview wmdow IS diVided Into a large view area
at the top of the Window and a varIety of controls governmg your
printing chOICes at the bottom of the Window The view area shows a
portion of what Will be printed

In the lower left of the Diagram PrInt Preview wmdow are two sets
of radIO buttons and an Options button

• No Color/Monochrome/Color governs the color and format of the
prmted output Choose one of these options No Color Will
produce a line draWing, Without any color filling If your pnnter IS
an older printer With less memory, you may be able to use thiS
optIOn If the others do not operate With your printer Monochrome



DICl!!ram Print Preview Window

will draw a grayscale Image with colors from black to white
Color will allow prmtmg of the diagram on color printers

• Landscape/PortraIt determines whether the view will be longer
than It IS tall (landscape) or taller than It IS long (portrait)

Immediately to the fight of the radiO button options IS an Inset
panel governing the view displayed above In the view area You can use
the Zoom buttons to scale your view to some percentage of the actual
size Zoom settings Will not affect the actual prlntmg of the diagram
they Will only affect your preview of It You can also zoom In closer by
double clicking on a portion of the Image In the view area Itself If
there IS more than one page In the output you can use the Page
buttons to toggle between the pages The Page buttons are shown
(when applicable) to the nght of the zoom buttons

The Choose Pnnter button Will access a small Window used to
select the printer To select a printer other than the one In the Current
Pnnter box click on a pnnter In the list It Will become the current (or
default) printer when you click on OK to close the Window

Choose Prmter Wmdow

Current Pnnter
lCanon BJC 250

Ayailable Pnnten.
"herosoll Fax
Rende"n!! Subsystem
Epson Aehonlaser 1500
Canon BJC 250

Warning Chan!JlR!l PflRters wiD affect aD
apphcahons Do not change the pflnter
while runnrng a pnnt lOb ~

Halt TO PRI/I,T 4"'0 bPORT t""oRMAnO\

Warmnl1

This will set the default printer for all adlve
Wmdows applications
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When you clIck the PrInt button the pages lIsted m the Prmt
page through page "area wIll prmt For example to prInt pages 2
through 4, type '2" m the first box and '4" m the second To prInt a
smgle page, fill m that page number In both boxes For smgle page
output, both boxes wIll be prefilled wIth 1

The dIagram prInted may span many pages The number of pages
wIll be determmed by the maxImum number of entIties m the matrIces
covered In the dIagram The pages have been designed to overlap to
facIlItate the productIOn of a large poster-sIzed dIagram

6.2 Exportinl! Report Data

Report data can be exported m the Export Data sectIOn of substep
8 Checks and Reports ThIs functIOn automatically exports all matrIces
In a project to a spreadsheet program In a Comma Separated Value
format ClIck on the Export Data button and save your matrIces as you
would any other document m a WIndows program When you open the
file m a spreadsheet package, some formattIng changes such as the
sIZIng of columns and rows, may be needed



Chapter 7

How to Use
National Health Acounts Tools

7.1 Settml!S

The SettIngs WIndow allows you to make certaIn choICes that affect
all analyses you perform wIth NatIOnal Health Accounts To access the
WIndow choose SettIngs under the FIle menu

Settm~s Wmdow

x

~
Slep Name-

Stepl [D To [] ICh E lie

St.p2: [J To [j ~ID'~hn~e=Flo:::w=====:
Step 3: I£] To @]ISelQu nfte

Step4 ~ To [] ~IA=:al.=ze~A=..==m=nl==:

Slop 5 0 To 0 ~I=======:
Slep6 0 To 01
Slep 7 0 To 0 ~I=======:

51.pS- 0 To 0 LI --'

Button Orrler

[D Choose Entmea:

[J D.rone flow

[j D.laded flo.. DlOgfam

[] Full flow D_em

IDE_.MaIm<
[] G.aph>

[] Matnx Greph

[!] Checks and Reports

,E,.ase Record of Completed Step~

Enbljo Sort D,d..- (0' N.... r Sector C- Clnlom

I Maino lmag. M"" \Yldlh (.u. """,lot~ (d<x:temenl d Maim doe> not displa,)

I~ ll.K _JI

One major functIon of thIS window IS to allow you to reorder
and/or rename the NHA substep buttons on each matrix screen The
default settIngs correspond to the substep order structure described
In prevIOUS chapters

The SettIngs screen also allows you to erase the record of completed
steps that IS recorded In the small white check boxes to the left of each
substep and In the Progress Checklist

The EntIty Sort Order settIng determInes the order In whIch entItles
WIll be dIsplayed on a varIety ofthe maIn WIndows In the system The
Custom sort order selection will cause the entItles to be dIsplayed based
on a code you enter for each entIty See the EdIt Entity WIndow
discussed In Chapter 4
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Matnx Image (Diagram) Max Width box can be used to adjust the
maximum Width In pixels ofthe Matnx Diagrams drawn by the software
Adjust this setting lower If the software does not draw Matnx Diagrams
properly The maximum settmg that Will operate on a given machine IS
roughly tied to available system memory

72 Database CompactinQ and Repair

7 2 1 Compactml! Projects

National Health Accounts project files ( NHA files) can grow to
considerable size In certain cIrcumstances such as when numerous
Items are deleted after bemg added, the NHA file can become larger
than necessary To reclaIm space used by the file, you can compact the
file via the Compact Project option on the Tool menu

When you select thiS option the system Will first check to see If It
has enough temporary space on disk to perform the operatIOn There
must be at least as much extra space on disk as the sIze of the file Thus
If your NHA file IS 360K In Size, you must have 360K free space on dIsk
to compact the file Compacting the file mvolves makmg a temporary
copy of the file

Once the checks are complete, the project WIll be closed and the
process WIll commence Once It has fimshed, a message box wIll
announce the completIOn To continue work on the project, open the
project

7 2 2 Repamnl! Projects

AVOId rebooting or turning your machine offwhIle NatIonal Health
Accounts IS running SometImes, dOing thIS WIll cause no damage to the
NatIOnal Health Accounts project file ( NHA file) In other cases
subsequent attempts to open the project file WIll result In a message
warning that the file IS •not a NatIonal Health Accounts' file or may be
corrupted" If thiS happens you can use the RepaIr Project option to
attempt to recover your data

To initiate the repair process chck on the RepaIr Project optIon on
the Tools menu If RepaIr Project IS done while a project IS open the
current project wIll be closed and repaired after you chck on OK on the
confirmatIOn message box When RepaIr Project IS Invoked and no
project IS open a Window Similar to the Open Project wmdow IS
displayed Select your damaged file vIa thIS Window and chck on OK

Repair Project also compacts the project after the repaIr step IS
complete You must have at least as much free space on the disk where
the NHA dIrectory IS located as the size of the file to be repaired

The Repair Database functIon cannot solve all possible losses of
data so back up your project ( NHA) files frequently



Glossary

AudIted Accounts estimates that are drawn from professIOnally audited
accounts

Acceptable Estlmates estimates that are based on reliable data
sources subjective accordIng to the data SituatIOn of each country

EntIty an organizatIOn group or type of use of funds

Fmanclng Agents entities which pay for or purchase health care
servICes may own and operate proVider InstitutIOns or may finance
servICes provided by others receive funds from sources and pay them
to proViders

Flow an avenue of expenditure between a source and a financIng
agent or a financIng agent and a use

Publlc ExpendIture on Health central government expenditures
through the mInistries of health and transfers to other governmental
public health InstItutIOns that operate with their own budgets health
expenditure by decentralized levels of government health
expenditures by SOCIal security systems or publicly funded SOCial
services programs (such as those aSSOCiated with the military)

Pnvate ExpendIture on Health direct out of pocket spendIng by
households to pay for general and speCialized medical services drugs
lab exams prostheses eyeglasses hearing aids and other durable
medical eqUIpment and clinical servICes and hospitalizatIOn spendIng
by firms of health Insurance premIUm or other expenditure on clinical
services and hospitalization

PrOVIders a type of use category refernng to those entities that are
direct proVIders of medICal care servICes

Sources entities who proVide funds to financIng agents who are direct
purchasers of or payers for health care

Unacceptable Estlmates estimates that are based on poor quality data
sources estimates In whICh you have no confidence

Annexes
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Acronyms
DDM Data for DecIsion Makmg
DOH Department of health
GOP Gross domestic product
HCFA Health Care FInancmg Administration
LAC Latin Amenca and Canbbean
MOH Ministry of health
NHA NatIOnal Health Accounts
OECD Organization for EconomiC Cooperation and Development
PAHO Pan Amencan Health OrganizatIOn
PHR Partnerships for Health Reform
PPP Purchasing power panties
USAID United Sates Agency for International Development
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